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What is Included with the NPC-2006 kit.

NPC-2006 Nitrous Controller.

Wiring Harness with sealed automotive connectors.

8ga heavy duty solenoid power supply wires.

High Amperage Relay.

Installation hardware kit.

USB flash drive with PC software and a pdf file of the user manual.
User Manual

USB communication cautions.
1—Do not leave the USB cable plugged into the controller during operation.

2—Do not use a laptop that is powered by a DC to AC invertor. This can create a floating ground condition
that can and will damage the USB interface.

3—Do not charge the vehicle battery while using the USB interface. When using a generator to power the
battery charger electrical spikes can occur that can potentially damage the USB interface.

4—If you must ignore the above precautions you do so at your own risk.

Important Information - When using a conventional style ignition coil (Not Coil on Plug) you must use
Static Suppression Ignition Wires with this Controller.

Caution - Do NOT submerge Controller in liquid or directly wash unit with liquid of any type! (Do NOT spray

when washing vehicle!)

It is the responsibility of the purchaser to follow all guidelines and safety procedures supplied with this product
and any other manufactures product used with this product. It is also the responsibility of the purchaser to determine
compatibility of this device with the vehicle and other components.

Induction Solutions assumes no responsibility for damages resulting from accident, improper installation, misuse,
abuse, improper operation, lack of reasonable care, or all previously stated reasons due to incompatibility with other
manufacturer's products.

Induction Solutions assumes no responsibility or liability for damages incurred from the use of products manu-
factured or sold by Induction Solutions on vehicles used for competition racing. Induction Solutions neither recommends
nor approves the use of products manufactured or sold by Induction Solutions on vehicles which may be driven on public
highways or roads, and assumes no responsibility for damages incurred from such use.

It is the purchaser’s responsibility to check the state and local laws pertaining to the use of Nitrous Oxide for rac-
ing applications. Induction Solutions does not recommend nor condone the use of its products for illegal street racing.

Warranty

Induction Solutions warrants to the original purchaser that the controller shall be free from defects in parts and
workmanship under normal use for 180 days from the date of purchase.

Induction Solutions obligation under this warranty is limited to the repair or replacement of any component
found to be defective when returned postpaid to Induction Solutions. The Controller must be returned with evidence of
place and date of purchase or warranty will be void. The warranty will not apply if the controller has been installed incor-
rectly, repaired, damaged, or tampered with by misuse, negligence or accident.
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System Requirements
Operating system

Windows XP Home or Professional with Service Pack 3 installed.

Information—if the text is not formatted or sized correctly with Windows XP operating system follow the instructions below
to adjust the display dots per inch (dpi) setting.

For Windows XP the screen dpi setting must be set to default or 96 dpi.
1—O0pen Display in Control Panel.

2—O0n the Settings tab, click Advanced.
3—O0n the General tab, in the DPI setting list, click 96 dots per inch (dpi).

4—Restart your computer when prompted.
Windows Vista all versions.
Windows 7 all versions.
Windows 8.x all versions.

Windows 10 all versions.

Software Installation Steps

The Nitrous Power Controller software is located on the USB flash drive included with the NPC-2006 kit. Plug the USB flash
drive into an available USB port on the computer.

Important—the software must be located and started manually from the USB flash drive. The auto run feature is not imple-
mented to provide increased security. Please follow the steps below to locate the software installation program.

Please use one of the following methods to open Windows file explorer.

1—Press the Windows logo key + e together.

2—click on the File Explorer icon in the task bar.

3—click Start, point to All Programs, point to Accessories, and then click Windows Explorer.
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Welcome to the Nitrous Power Controller Setup
Wizard

The inztaller will guide vou through the steps required to ingtall Mitrous Power Controller on pour
computer.

WARMIMG: This computer program iz protected by copuright law and international treaties.
Unautharized duplication ar distribution of this pragrarn, ar any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted ta the maximum extent possible under the law.

Click on the “Next” button and follow the installation wizard prompts as needed.
Important—Please allow the installation wizard to install the software in the default location when prompted.
You may be prompted to allow installation from an unknown publisher, click on “Yes” to continue with installation.

Allow the installation program to complete.

g/
i

On the Windows desktop you will find a “Nitrous Power Controller” icon.

Mitrous
F

Caontroller

Double click to start the software.

Note—When the software is installed a link to start the software will also be placed in the program start menu. The installation pro-
gram also creates a link to un-install the software. If you no longer wish to have it installed or you need to remove a previous version
before updating to a more current version you may select this link from the All Programs/Induction Solutions selection.



General Overview
Toolbar menu

Hover mouse cursor over icon for
information. Tabbed navigation buttons

Menu bar

L1} NPC—ZOG&NE‘(:‘GUS Power Controller Version 1.0.2 | = | = %1

File Controller Preferences Data /ﬁp /
kDO Vg 4
Stage1 | Stage2| Timer Stagel | Timer Stage2| Relay Output| Configuration| Data |
Setup | Nitrous | Fuel |

StageT Delay Timer

0.000 Amount of time until Stage1 starts after Activatio

< Click on the “I” buttons for help.

[l Enable Stage1 RPM control.
Stage1 RPM Window
7] 1000 | Stage Minimum RPM.

9000 ;| stagel Maximum RPM.

Synchronize Solenoid Pulse Frequency
All Solenocids use Stage1 Nitrous pulse frequency.

Stage1 Synchronize Pulse Frequency

| NPC-2006 Controller Not Connected | Controller Firmware Version = || Untitled.npc |

Progress bar— this pro- Firmware version—this indi-
vides visual feedback for cates the current firmware
read and write operations installed in the controller.

to the controller through
the USB interface.

. ) Current setup file in use.
USB connection status— this

indicates a valid USB connec-
tion has been established with

the controller.



File Menu

————

 NPC-2006, Nitrous Power

File | Controller |
% Open File
1l Save File

Save As

A Edt

Open File—open setup file that has been previously saved to the computer.

Save File—save current setup file to computer. This option saves the current setup data from the Nitrous Power
Controller software. It does not save the setup data from the controller to the computer.

Save As—save current setup file to computer with the option to save as a copy with a different name.

Exit—Exit and close the Nitrous Power Controller software.

Controller Menu

Controller ‘ Preferences Data Help

7 Download Setup from Controller
@ Upload Setup to Controller

T Download Data Log from Controller

% Update Controller Firmware

Important—the controller must be connected to the computer with the USB cable and the controller must be
powered up to use the following menu selections. Only the Switched +12V power (key on) needs to be on for
USB communication, the arming switch should be in the off position.

Always allow the progress bar in the lower left corner to complete after starting a download or upload to the
controller.

Download Setup from Controller—read setup data from the controller to the Nitrous Power Controller soft-
ware. Note—after downloading the setup data from the controller you may use the File Menu, Save File selec-
tion to save the setup data to a file on the computer.

Upload Setup to Controller—write current setup data from the Nitrous Power Controller software to the con-
troller. Note—to load a saved setup file from the computer to the controller, first use File Menu, Open File to
load the file. After opening the file use this selection to write the setup to the controller.

Download Data Log from Controller—read data log information from the controller. This selection will read the
most recent data log information from the controller. Note—the controller will retain the last data logged even
if the controller is powered off.

Update Controller Firmware—load a new firmware image file into the controller. The firmware is the operating
system for the controller. When a new and/or updated version is released that has additional features, or a fix
for an unforeseen issue, this selection is used to apply the update to the controller.



Preferences Menu

Preferences | Data Help
Load Last File on Startup

Load Last File on Startup—if the option is selected (checkmark present) the most recent setup file will be auto-
matically opened when the Nitrous Power Controller software is launched. Note—if the file does not exist or

has been moved to a new location the default setup will opened.

Data Menu

Data | Help

I~ Open Data Log File
iy Save Data Log File

Open Data Log File—open a data log file that has been previously saved to the computer.

Save Data Log File—save data log information to a file on the computer. To save data log information from the
controller to a file. First use Controller Menu, Download Data Log from Controller and then use this selection to

save the data log information to the computer.

Help Menu

Help |
About

About—this selection displays a small window with software version information.
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Stagel Tab—Setup

StageT Delay Timer
|j| 0.000- Amount of time until Stage1 starts after Activation.

Stagel Delay Timer - this setting sets the delay time in seconds before Stagel starts after Activation.
Valid range - 0.000 to 10.000 in .001 second increments.

‘i‘ | Enable Stage1 RPM control. Note—If the RPM window feature is enabled and the engine
is not running the solenoids can be dry fired for testing. Once
i 3000 an RPM signal is present the solenoids will only fire at the

desired RPM range.
6000 g

Enable Stagel RPM control - this setting enables a RPM Window function for Stagel.

Stagel Minimum RPM - this setting controls the minimum engine RPM that must be achieved before Stagel will turn On. A setting of
0 will disable the Minimum RPM function and the Maximum RPM setting will be used to turn off Stagel if the engine RPM exceeds the
setting.

Valid range - 0 to 15,900 RPM in 10 RPM Increments.

Stagel Maximum RPM - this setting controls the maximum engine RPM that Stagel remains On. When the engine RPM exceeds this
setting Stagel will be turned Off. The Maximum RPM must be at least 100 RPM greater than the Minimum RPM setting.
Valid range - 1000 to 16,000 RPM in 10 RPM increments.

Synchronize Solenoid Pulse Frequency
E| ¥ All Solenoids use Stage1 Nitrous pulse frequency.

Synchronize Solenoid Pulse Frequency
All Solenoids use Stagel Nitrous pulse frequency (hertz) - this setting forces all solenoid outputs to operate at the Stagel Nitrous Sole-
noid Pulse Frequency setting. The controls to adjust individual solenoid output frequencies will be disabled when this setting is On.

Stagel Synchronize Pulse Frequency - the Stagel nitrous and fuel solenoids can be configured to function at the nitrous solenoid fre-
quency only (both Stagel outputs synchronized). Or the Stagel nitrous and fuel solenoid output frequencies may be set independent-
ly.

IMPORTANT - if you choose to operate the nitrous and fuel solenoids at different frequencies (hertz) you MUST insure that both sole-
noids operate as desired in the delivery of nitrous and fuel to the engine!

Information - the solenoid pulse frequency (hertz) is how many times per second the solenoids open and close when not at 0 or 100
percent operation. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 times per sec-
ond. Total time for each pulse =1/ 10 = .1 second, total time solenoid would be on =.1 * .50% = .05 second.

There are many different styles of solenoids available and they will react differently to changes in the operating frequency. It is up to
the user to verify that the solenoids are opening properly with the settings used for operation

As a general rule a lower frequency setting will allow a solenoid to open properly when a high nitrous pressure is used and a low
starting percentage. This is just a general rule, test your settings!

10
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Stagel Tab—Nitrous Graph

Stage1 Nitrous
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Graph Control Editing

Left click on a data point to enable editing for that data point. Left click and drag to adjust the value of the selected data

point. Click on the graph or another data point to disable the current edit point.

Double left click on a data point to set an anchor point, once the anchor point is set left click on another data point and

when the value is changed the graph will auto fill between the anchor point and the current edit point. Click on the anchor

point or anywhere in the graph to clear the anchor point.

Once the graph is the active control (click on graph) the keyboard may also be used to edit the data points.
CTRL+S - set edit point to center of graph data.

Left and Right keys - move the current edit point left or right.

Up Arrow and Down Arrow - adjust current data point up or down in 1% increments.

CTRL + Up Arrow and CTRL + Down Arrow - adjust current data point up or down in .1% increments.
ENTER - set anchor point at current edit point. No action if there is no current edit point.

ESC - clear edit and anchor point(s).

Note—the Stagel Fuel graph ramp will appear in the background to provide a visual reference.

Stage1 Copy Graph Data
@ ‘COPY to Stage1 Fuel h Use this feature to Copy the contents of the graph control to other graph
controls.

o |

11
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Stage1 Nitrous Pulse Frequency
‘iJ 20" Solenoid pulse per second

Important—if the “All Solenoids use Stagel Nitrous pulse frequency.” option is checked this setting will control all nitrous

and fuel solenoid frequency (hertz). See Stagel Setup and Stage2 Setup for more information.

The solenoid pulse frequency (or also known as Hertz) is how many times the solenoids open and close when not at 0 or 100 percent
operation. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 times per second. Total
time for each pulse =1 /10 = .1 second, total time solenoid would be on =.1 * .50% = .05 second.

Stagel Nitrous Resume Ramp
|E 35.0" Nitrous resume percentage

10.0 Percent per Pulse

Resume Start Percent - This setting determines the percent the Stagel Nitrous resumes at if the user has to lift the throttle during Acti-
vation. This setting is only valid if the Hold And Wait option is ON. This setting is used with the Resume Percent per Pulse setting to
build a Resume Ramp. If the Resume Start Percent is greater than the current output percent the resume ramp is ignored.

Valid range - 10% to 100% in .1% increments. A setting of 100% disables this feature.

Resume Percent per Pulse - This setting determines the rate at which the Nitrous Resumes if the user lifts the throttle during Activa-
tion. This setting is used with the Resume Start Percent to build a Resume Ramp. This allows the user to adjust how quick the nitrous

comes back on if the Activation signal is removed.

Example - 10% per pulse would increase the rate 10% for each pulse starting at the Resume Start Percent setting. 35% Resume and
then each pulse of the solenoid would increment 10% until the setting in the ramp is is achieved. After the resume ramp is completed

the normal build time ramp is followed.

Valid range - 10% to 50% in .1% increments.

Stage1 Quick Ramp Builder
E| 20.0: | start Percentage

100.0: Final Percentage

4.0 Build Time ‘ fccapt ‘

Quick Ramp Builder - Use this selection to do quick progressive setups. This feature allows the nitrous to be setup using a Start Per-
centage, Final Percentage, and a Build Time.

Start Percentage - This setting determines the ramp Starting Percentage. The Start Percent can be less than or greater than the Final
Percent setting. If the Start Percent is greater than the Final Percent the ramp will progress backwards.

Valid range - 0% to 100% in .1% increments.

Final Percent - This setting determines the ramp Final Percentage. The Final Percent can be less than or greater than the Start Percent
setting. If the Start Percent is greater than the Final Percent the ramp will progress backwards.

Valid range - 0% to 100% in .1% increments.

Build Time - This setting determines the time it takes for the nitrous to ramp from the Start Percent to the Final Percent settings. A
short Build Time will make the nitrous ramp more aggressive and a longer Build Time will make it less aggressive.

Valid range - .200 to 9.900 seconds in .1 second increments.

12
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Stagel Tab—Fuel Graph

Stage Fuel
100.0-
90.0-
S Stagel Nitrous ramp \
: O Edit point
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g
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| kLl | Current Value = 89.9, Time = 5.000 Stage1 Fuel Build Time

Graph Control Editing

Left click on a data point to enable editing for that data point. Left click and drag to adjust the value of the selected data
point. Click on the graph or another data point to disable the current edit point.

Double left click on a data point to set an anchor point, once the anchor point is set left click on another data point and
when the value is changed the graph will auto fill between the anchor point and the current edit point. Click on the anchor

point or anywhere in the graph to clear the anchor point.

Once the graph is the active control (click on graph) the keyboard may also be used to edit the data points.
CTRL+S - set edit point to center of graph data.

Left and Right keys - move the current edit point left or right.

Up Arrow and Down Arrow - adjust current data point up or down in 1% increments.

CTRL+Up Arrow and CTRL+Down Arrow - adjust current data point up or down in .1% increments.

ENTER - set anchor point at current edit point. No action if there is no current edit point.

ESC - clear edit and anchor point(s).

Note—the Stagel Nitrous graph ramp will appear in the background to provide a visual reference.

Stagel Copy Graph Data
E| ‘Copy to Stage1 Nitrous ~ Use this feature to Copy the contents of the graph control to other graph
controls.

o
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] 20| Solenoid pulse per second

Important—the “All Solenoids use Stagel Nitrous pulse frequency.” option must be un-checked (off) When this feature is
enable the Stage2 solenoid frequency (hertz) can be adjusted independently of the Stagel frequency (hertz).

The solenoid pulse frequency (or also known as Hertz) is how many times the solenoids open and close when not at 0 or 100 percent
operation. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 times per second. Total
time for each pulse =1 /10 = .1 second, total time solenoid would be on =.1 * .50% = .05 second.

Stagei Fuel Resume Ramp
‘E‘ 35.0> Fuel resume percentage

10.0;0 Percent per Pulse

Resume Start Percent - This setting determines the percent the Stagel Fuel resumes at if the user has to lift the throttle during Activa-
tion. This setting is only valid if the Hold And Wait option is ON. This setting is used with the Resume Percent per Pulse setting to build
a Resume Ramp. If the Resume Start Percent is greater than the current output percent the Resume Ramp is ignored.

Valid range - 10% to 100% in .1% increments. A setting of 100% disables this feature.

Resume Percent per Pulse - This setting determines the rate at which the Fuel Resumes if the user lifts the throttle during Activation.
This setting is used with the Resume Start Percent to build a Resume Ramp. This allows the user to adjust how quick the fuel comes
back on if the Activation signal is removed.

Example - 10% per pulse would increase the rate 10% for each pulse starting at the Resume Start Percent setting. 35% Resume and
then each pulse of the solenoid would increment 10% until the setting in the ramp is is achieved. After the resume ramp is completed
the normal build time ramp is followed.

Valid range - 10% to 50% in .1% increments.

Stage! Quick Ramp Builder
E| 20.01 start Percentage

100.0 Final Percentage

4.0° BuildTime ‘ fcsenl ‘

Quick Ramp Builder - Use this selection to do quick progressive setups. This feature allows the fuel to be setup using a Start Percent-
age, Final Percentage, and a Build Time.

Start Percentage - This setting determines the ramp Starting Percentage. The Start Percent can be less than or greater than the Final
Percent setting. If the Start Percent is greater than the Final Percent the ramp will progress backwards.

Valid range - 0% to 100% in .1% increments.

Final Percent - This setting determines the ramp Final Percentage. The Final Percent can be less than or greater than the Start Percent
setting. If the Start Percent is greater than the Final Percent the ramp will progress backwards.

Valid range - 0% to 100% in .1% increments.

Build Time - This setting determines the time it takes for the fuel to ramp from the Start Percent to the Final Percent settings. A short
Build Time will make the fuel ramp more aggressive and a longer Build Time will make it less aggressive.

Valid range - .200 to 9.900 seconds in .1 second increments.

14
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Stage2 Tab—Setup

E‘ [l Enable Stage2

Enable Stage2—this setting allows the entire Stage2 system to be turned off/on as desired.
Important—when Stage is off the Stage2 Timer output will be disabled as well as any Stage2 settings for Timerl Output and the Relay

output.
: Stage2 Delay Timer - this setting sets the delay time in seconds
Stage2 Delay Timer & v & y
fas » ) ) L before Stage2 starts after Activation.
|J‘ 0.000: Amount of ime until Stage? starts after Activation.

Valid range - 0.000 to 10.000 in .001 second increments.

Enable Stage2 RPM control - this setting enables a RPM Window function for Stage2.

E| [l Enable Stage2 RPM control. Note—If the RPM window feature is enabled and the engine is
not running the solenoids can be dry fired for testing. Once an
AL 10007 stage2 Minimum RPM. RPM signal is present the solenoids will only operate at the

9000 Stage2 Maximum RPM. desired RPM range.

Stage2 Minimum RPM - this setting controls the minimum engine RPM that must be achieved before Stage2 will turn On. A setting of
0 will disable the Minimum RPM function and the Maximum RPM setting will be used to turn off Stage2 if the engine RPM exceeds the
setting.

Valid range - 0 to 15,900 RPM in 10 RPM Increments.

Stage2 Maximum RPM - this setting controls the maximum engine RPM that Stage2 remains On. When the engine RPM exceeds this
setting Stage2 will be turned Off. The Maximum RPM must be at least 100 RPM greater than the Minimum RPM setting.
Valid range - 1000 to 16,000 RPM in 10 RPM increments.

Syncrhonize Solenoid FPulse Frequency

@)

Stage2 Synchronize Pulse Frequency - the Stage2 nitrous and fuel solenoids can be configured to function at the nitrous sole-
noid frequency (hertz) only (both Stage2 outputs synchronized). Or the Stage2 nitrous and fuel solenoid output frequencies (hertz)
may be set independently.

Note—this option is only available if the All Solenoids use Stagel Nitrous pulse frequency is enabled in the Stagel Setup.

IMPORTANT - if you choose to operate the nitrous and fuel solenoids at different frequencies (hertz) you MUST insure that both sole-
noids operate as desired in the delivery of nitrous and fuel to the engine!

Information - the solenoid pulse frequency (hertz) is how many times per second the solenoids open and close when not at 0 or 100
percent operation. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 times per sec-
ond. Total time for each pulse =1/ 10 = .1 second, total time solenoid would be on =.1 * .50% = .05 second.

There are many different styles of solenoids available and they will react differently to changes in the operating frequency. It is up to
the user to verify that the solenoids are opening properly with the settings used for operation

As a general rule a lower frequency setting will allow a solenoid to open properly when a high nitrous pressure is used and a low
starting percentage. This is just a general rule, test your settings!

15
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Stage2 Tab—Nitrous Graph
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Graph Control Editing

Left click on a data point to enable editing for that data point. Left click and drag to adjust the value of the selected data
point. Click on the graph or another data point to disable the current edit point.

Double left click on a data point to set an anchor point, once the anchor point is set left click on another data point and
when the value is changed the graph will auto fill between the anchor point and the current edit point. Click on the anchor
point or anywhere in the graph to clear the anchor point.

Once the graph is the active control (click on graph) the keyboard may also be used to edit the data points.
CTRL+S - set edit point to center of graph data.

Left and Right keys - move the current edit point left or right.

Up Arrow and Down Arrow - adjust current data point up or down in 1% increments.

CTRL+Up Arrow and CTRL+Down Arrow - adjust current data point up or down in .1% increments.

ENTER - set anchor point at current edit point. No action if there is no current edit point.

ESC - clear edit and anchor point(s).

Note—the Stage2 Fuel graph ramp will appear in the background to provide a visual reference.

Stage?2 Copy Graph Data
\i/ ‘Copy to Stage2 Fuel -

Use this feature to Copy the contents of the graph control to other graph

controls.

16
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7] 20 Solenoid pulse per second

Important—the “All Solenoids use Stagel Nitrous pulse frequency.” option must be un-checked (off) and the “Stagel Ni-
trous and Fuel Solenoids independent frequency.” must be selected for the feature to enabled. When this feature is ena-
ble the fuel solenoid frequency (hertz) can be adjusted independently of the nitrous frequency (hertz).

The solenoid pulse frequency (or also known as Hertz) is how many times the solenoids open and close when not at 0 or 100 percent
operation. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 times per second. Total
time for each pulse =1 /10 = .1 second, total time solenoid would be on =.1 * .50% = .05 second.

Stage? Nitrous Resume Ramp
‘AJ 35.0 Nitrous resume percentage

10.0 Percent per Pulse

Resume Start Percent - This setting determines the percent the Stage2 Nitrous resumes at if the user has to lift the throttle during Acti-
vation. This setting is only valid if the Hold And Wait option is ON. This setting is used with the Resume Percent per Pulse setting to
build a Resume Ramp. If the Resume Start Percent is greater than the current output percent the Resume Ramp is ignored.

Valid range - 10% to 100% in .1% increments. A setting of 100% disables this feature.

Resume Percent per Pulse - This setting determines the rate at which the Nitrous Resumes if the user lifts the throttle during Activa-
tion. This setting is used with the Resume Start Percent to build a Resume Ramp. This allows the user to adjust how quick the nitrous

comes back on if the Activation signal is removed.

Example - 10% per pulse would increase the rate 10% for each pulse starting at the Resume Start Percent setting. 35% Resume and
then each pulse of the solenoid would increment 10% until the setting in the ramp is is achieved. After the resume ramp is completed
the normal build time ramp is followed.

Valid range - 10% to 50% in .1% increments.

Stage?2 Quick Ramp Builder
|i| 20.0: start Percentage

100.0 Final Percentage

4.0 Build Time ‘ Accept

Quick Ramp Builder - Use this selection to do Quick Progressive setups. This feature allows the nitrous to be setup using a Start Per-

centage, Final Percentage, and a Build Time.

Start Percentage - This setting determines the ramp Starting Percentage. The Start Percent can be less than or greater than the Final
Percent setting. If the Start Percent is greater than the Final Percent the ramp will progress backwards.

Valid range - 0% to 100% in .1% increments.

Final Percent - This setting determines the ramp Final Percentage. The Final Percent can be less than or greater than the Start Percent
setting. If the Start Percent is greater than the Final Percent the ramp will progress backwards.

Valid range - 0% to 100% in .1% increments.

Build Time - This setting determines the time it takes for the nitrous to ramp from the Start Percent to the Final Percent settings. A
short Build Time will make the nitrous ramp more aggressive and a longer Build Time will make it less aggressive.

Valid range - .200 to 9.900 seconds in .1 second increments.
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Stage2 Tab—Fuel Graph

Stage2 Fusl

Haiag fang Zebalg

0.000 1 IZ::IZI 2 ::IIZ-ZI 3 :II:ZJ 4000 5000
| Stage2 Fuel Build Time

Graph Control Editing

Left click on a data point to enable editing for that data point. Left click and drag to adjust the value of the selected data
point. Click on the graph or another data point to disable the current edit point.

Double left click on a data point to set an anchor point, once the anchor point is set left click on another data point and
when the value is changed the graph will auto fill between the anchor point and the current edit point. Click on the anchor
point or anywhere in the graph to clear the anchor point.

Once the graph is the active control (click on graph) the keyboard may also be used to edit the data points.
CTRL+S - set edit point to center of graph data.

Left and Right keys - move the current edit point left or right.

Up Arrow and Down Arrow - adjust current data point up or down in 1% increments.

CTRL + Up Arrow and CTRL + Down Arrow - adjust current data point up or down in .1% increments.

ENTER - set anchor point at current edit point. No action if there is no current edit point.

ESC - clear edit and anchor point(s).

Note—the Stage2 Nitrous graph ramp will appear in the background to provide a visual reference.

Stagel Copy Graph Data

E| ‘COPY to Stage1 Nitrous "] Use this feature to Copy the contents of the graph control to other graph

controls.
Copy ‘

18



19

Stage?2 Fuel Pulse Frequency
\i‘ 207 Solenoid pulse per second

Important—the “All Solenoids use Stagel Nitrous pulse frequency.” option must be un-checked (off) and the “Stage2 Ni-
trous and Fuel Solenoids independent frequency.” must be selected for the feature to enabled. When this feature is ena-
ble the fuel solenoid frequency (hertz) can be adjusted independently of the nitrous frequency (hertz).

The solenoid pulse frequency (or also known as Hertz) is how many times the solenoids open and close when not at 0 or 100 percent
operation. Example - pulse frequency set to 10 hertz and 50 percent, the solenoids would open and close 10 times per second. Total
time for each pulse =1 /10 = .1 second, total time solenoid would be on =.1 * .50% = .05 second.

Stage? Fuel Resume Ramp
|E 35.0: Fuel resume percentage

10.07 Percent per Pulse

Resume Start Percent - This setting determines the percent the Stage2 Fuel resumes at if the user has to lift the throttle during Activa-
tion. This setting is only valid if the Hold And Wait option is ON. This setting is used with the Resume Percent per Pulse setting to build
a Resume Ramp. If the Resume Start Percent is greater than the current output percent the Resume Ramp is ignored.

Valid range - 10% to 100% in .1% increments. A setting of 100% disables this feature.

Resume Percent per Pulse - This setting determines the rate at which the Nitrous Resumes if the user lifts the throttle during Activa-
tion. This setting is used with the Resume Start Percent to build a Resume Ramp. This allows the user to adjust how quick the fuel
comes back on if the Activation signal is removed.

Example - 10% per pulse would increase the rate 10% for each pulse starting at the Resume Start Percent setting. 35% Resume and
then each pulse of the solenoid would increment 10% until the setting in the ramp is is achieved. After the resume ramp is completed
the normal build time ramp is followed.

Valid range - 10% to 50% in .1% increments.

Stage? Quick Ramp Builder
E| 20.0; start Percentage

100.0 Final Percentage

4.0° Build Time ‘ fceenl ‘

Quick Ramp Builder - Use this selection to do quick progressive setups. This feature allows the fuel to be setup using a Start Percent-
age, Final Percentage, and a Build Time.

Start Percentage - This setting determines the ramp Starting Percentage. The Start Percent can be less than or greater than the Final
Percent setting. If the Start Percent is greater than the Final Percent the ramp will progress backwards.

Valid range - 0% to 100% in .1% increments.

Final Percent - This setting determines the ramp Final Percentage. The Final Percent can be less than or greater than the Start Percent
setting. If the Start Percent is greater than the Final Percent the ramp will progress backwards.

Valid range - 0% to 100% in .1% increments.

Build Time - This setting determines the time it takes for the fuel to ramp from the Start Percent to the Final Percent settings. A short
Build Time will make the fuel ramp more aggressive and a longer Build Time will make it less aggressive.

Valid range - .200 to 9.900 seconds in .1 second increments.
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Timer Stagel Tab

Timer Stage1 Configuration

|£| ¥ Timing Retard Control

20

Stagel Timer, Timing Retard Control - this setting configures the Stagel Timer, +12V output to be On whenever Stagel Nitrous

is On (Solenoids functioning). Check to enable.

If this setting is Off then the Timer1 output can be configured by selecting which control parameters are used to turn On the output.

When more than one control parameter has been selected all must meet the conditions as configured before the output will function.

Example - Activation Input Enabled and RPM Enabled, RPM On = 2000 and RPM Off = 4000, the Timerl output will only be on when the
Activation Input is active and the engine rpm is between 2000 and 4000 rpm.

This output supplies +12V when On.

This output may be used to drive an external relay with a load of no more than 1 amp. The relay can then be used to control another

stage of nitrous with no progressive ramp.

Timer Stage1 Configuration

|E [ Activation Input
[l Clutch/Trans Brake Input

be enabled.

¥ Delay Timer

¥ Engine RPM

7] Stage1 Nitrous% Enable
7| Stage1 Fuel% Enable

7] Stage2 Nitrous% Enable
7| Stage2 Fuel% Enable

Note—the “Timing Retard Control” must be un-checked (off) for these features to

Timer Stagel Configuration - check to enable which control parameters are used to deter-
mine when the Stagel Timer +12V output will be On. This output supplies +12V when On.
Any options that are selected are combined to determine if the output should be on or off.

Delay Timer - these settings control the Delay time and On time
for the Timer output.

Valid range - 0.000 to 10.000 in .001 Second increments.

Engine RPM - these settings control the output based on Engine
RPM.

Valid range - 0 to 16000 in 10 RPM increments.

Delay Timer

(@  1.000: oNDelay
Stagel Nitrous Percent - 4.000° OFF Delay
these settings control the
output based on Stagel Stage1 Nitrous Percent
Nitrous Percent. |i| 0.0 ON Percent
Valid range - 0.0 to 100.0 0.07 OFF Percent
in .1 Percent increments. .

Stage? Nitrous Percent

\i‘ 0.0 ON Percent

0.0 OFF Percent

RPM
@ 800 ONRPM
9500 OFFRPM Stagel Fuel Percent - these
settings control the output
Stagel Fuel Percent based on Stagel Fuel Per-
" 1| 0.0 > ON Percent cent.
0.07 OFF Percent Valid range - 0.0 to 100.0
in .1 Percent increments.
Stage? Fuel Percent
‘i‘ 0.0> ON Percent
0.0 OFF Percent

Stage2 Nitrous Percent - these settings control the output
based on Stage2 Nitrous Percent.

Valid range - 0.0 to 100.0 in .1 Percent increments.

Stage2 Fuel Percent - these settings control the output based on
Stage2 Fuel Percent.

Valid range - 0.0 to 100.0 in .1 Percent increments.
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Timer Stage2 Tab
Timer Stage?2 Configuration
‘E [ Timing Retard Control

21

Stage2 Timer, Timing Retard Control - this setting configures the Stage2 Timer, +12V output to be On whenever Stage2 Nitrous

is On (Solenoids functioning). Check to enable.

If this setting is Off then the Timer2 output can be configured by selecting which control parameters are used to turn On the output.

When more than one control parameter has been selected all must meet the conditions as configured before the output will function.

Example - Activation Input Enabled and RPM Enabled, RPM On = 2000 and RPM Off = 4000, the Timer2 output will only be on when the
Activation Input is active and the engine rpm is between 2000 and 4000 rpm.

This output supplies +12V when On.

This output may be used to drive an external relay with a load of no more than 1 amp. The relay can then be used to control another

stage of nitrous with no progressive ramp.

Timer Stage?2 Configuration

@ [l Activation Input

[] Clutch/Trans Brake Input be enabled.

¥ Delay Timer

Note—the “Timing Retard Control” must be un-checked (off) for these features to

Timer Stagel Configuration - check to enable which control parameters are used to deter-

¥ Engine RPM

] Stage1 Nitrous% Enable
v Stage1 Fuel% Enable

v Stage2 Nitrous% Enable
v Stage2 Fuel% Enable

mine when the Stagel Timer +12V output will be On. This output supplies +12V when On.
Any options that are selected are combined to determine if the output should be on or off.

Delay Timer - these settings control the Delay time and On time
for the Timer output.

Valid range - 0.000 to 10.000 in .001 Second increments.

Engine RPM - these settings control the output based on Engine
RPM.

Valid range - 0 to 16000 in 10 RPM increments.

Delay Timer

(@  1.000: oNDelay
Stagel Nitrous Percent - 4.000° OFF Delay
these settings control the
output based on Stagel Stage1 Nitrous Percent
Nitrous Percent. |i| 0.0 ON Percent
Valid range - 0.0 to 100.0 0.07 OFF Percent
in .1 Percent increments. .

Stage? Nitrous Percent

\i‘ 0.0 ON Percent

0.0 OFF Percent

RPM
@ 800 ONRPM
9500 OFFRPM Stagel Fuel Percent - these
settings control the output
Stagel Fuel Percent based on Stagel Fuel Per-
" 1| 0.0 > ON Percent cent.
0.07 OFF Percent Valid range - 0.0 to 100.0
in .1 Percent increments.
Stage? Fuel Percent
‘i‘ 0.0> ON Percent
0.0 OFF Percent

Stage2 Nitrous Percent - these settings control the output
based on Stage2 Nitrous Percent.

Valid range - 0.0 to 100.0 in .1 Percent increments.

Stage2 Fuel Percent - these settings control the output based on
Stage2 Fuel Percent.

Valid range - 0.0 to 100.0 in .1 Percent increments.
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Relay Output Tab

Relay Output Configuration

|Q [ Activation Input

[l Clutch/Trans Brake Input

v Stage2 Fuel% Enable

mine when the Relay output will be On.

This output provides a Ground when it is On.

Maximum current draw is 1 amp.

22

Relay Output Configuration - check to enable which control parameters are used to deter-

Delay Timer - these settings control the Delay time and On time

for the Relay output.

Valid range - 0.000 to 10.000 in .001 Second increments.

Engine RPM - these settings control the output based on Engine

RPM.

Valid range - 0 to 16000 in 10 RPM increments.

Stagel Nitrous Percent -
these settings control the
output based on Stagel
Nitrous Percent.

Valid range - 0.0 to 100.0
in .1 Percent increments.

Delay Timer
|i‘ 1.000 ON Delay
4.000 OFF Delay

Stage1 Nitrous Percent
|i| 0.0 ON Percent

0.0° OFF Percent

Stage? Nitrous Percent
E‘ 0.0 ON Percent
0.0- OFF Percent

RPM
@) 800 ONRPM
9500 OFF RPM

Stage1 Fuel Percent

E 0.0 ON Percent
0.0 OFF Percent

Stage? Fuel Percent

‘i‘ 0.0:>| ON Percent

0.0- OFF Percent

Stagel Fuel Percent - these
settings control the output
based on Stagel Fuel Per-
cent.

Valid range - 0.0 to 100.0
in .1 Percent increments.

Stage2 Nitrous Percent - these settings control the output

based on Stage2 Nitrous Percent.

Valid range - 0.0 to 100.0 in .1 Percent increments.

Stage2 Fuel Percent - these settings control the output based on

Stage2 Fuel Percent.

Valid range - 0.0 to 100.0 in .1 Percent increments.
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Configuration Tab

Main Timer

‘.J‘ 20| This controls the maximum time the outputs are active before the controller Resets.

Main Timer - This setting controls the Main Timer period. This controls the total time elapsed before a System Timeout occurs. This
limits the total amount of time the solenoids can be On if the Activation signal is never removed.

Once the Main Timer has timed out the Activation signal must be removed before the controller may be activated again.
Valid range - 20 to 300 in 1 second increments.

Hold and Wait
\i‘ @ Hold and Wait when Activation signal is removed. (ON)

© Reset controller when Activation signal is removed. (OFF)

Hold & Wait - This setting allows the Progressive system to Hold & Wait when the Activation signal is removed.

Example - the throttle is lifted due to wheel spin (Activation signal removed). If Hold & Wait is ON the Progressive system will resume
at the point where the throttle was lifted. See Nitrous and Fuel Resume Ramp for additional resume features.

If this option is OFF the Progressive system and All Timers will reset each time the Activation is removed.

Clutch/Trans Brake Input Delay Timer

|1| 0.000" Controls the amount of time input is ON before itis recognized after controlleris Activated.

Clutch/Trans Brake Input Delay Timer - this setting controls how long the Clutch/Trans Brake input must be On before accepting the
signal. The clutch input hold delay setting is ignored until the controller is Activated.

Before the controller is Activated the clutch input is recognized in real time with no delay.

This setting could be used to ignore shifts with a manual transmission (1 second) or a very low setting would act as noise filter to ignore
spurious signals (.005 second).

If a clutch input signal is recieved and accepted after the controller is activated the system will turn off the progressive system and tim-
ers. This would allow the nitrous to be turned Off during a shift and resumed when the clutch is released.

Valid range - 0.000 to 1.000 in .001 second increments. (0.000 turns this function OFF)

Tach Inpur Pulse Per Revolution

‘\;‘ ‘4 Pulse per Revolution ~| Number of tach signal pulse per revolution of crankshaft.

Tach Input Pulse Per Revolution - this setting determines the number of Tach Pulses per revolution of the crankshaft.

Example - if the Tach Signal input is connected to a common V8 engine multi-spark ignition controller a setting of 4 Pulse per Revolu-
tion would be used.

Common settings are,

1 Pulse per Two Revolutions = modern coil on plug systems with white wire connected to single coil wire.
1 Pulse per Revolution = single cylinder engine and some twin cylinder motorcycle engines.

2 Pulse per Revolution = 4 cylinder car and motorcycle engines.

3 Pulse per Revolution = 6 cylinder engines.

4 Pulse per Revolution = 8 cylinder engines.

5 Pulse per Revolution = 10 cylinder engines.
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Data Tab — Data Setup
Data Log Activation - these settings determine when the controller begins recording data.
Data Log Activation
= . If more than one option is selected ALL conditions must be met before a new data log will
| 1| 7 Activation Input
— start.
Clutch/Trans Brake Input
Example - Activation input and Clutch/Trans Brake input both selected, a new data log will

=i REM begin recording when both inputs are active. This would be a typical setup when making a
pass at the track. Once staged the Clutch/Trans Brake would be on, then when the wide
open throttle switch goes active the controller would begin a new data log..

7 2000} Activation RPM

Example if on a chassis dyno and the Clutch/Trans Brake input is not being used you would
want to have only Activation input selected to start a new data log..

RPM - this setting determines the Engine RPM when the controller begins recording data.

Valid range - 1,000 to 10,000 in 10 RPM increments.

Data Tab — Data Chart

/ Click title to turn on/off Drag chart height here to adjust title display
Stage] Nitrous Parcant = 90.0 Solenoid Voltage = 12.1 Relay Output = 0
Stage1 Fuel Percent = 0.0 Achivalion Input = 1 |
Stage2 Nitrous Percent = 90.0 Clutch Input = 0
Stage2 Fuel Percent = 90.0 Clutch Input Fillered = 0
Engine RPM = 0 Timer] Output = 1 .
Batlery Voltage = 12.1 Timer? Output = 1

Achivation Input = 1

Current Tima = 9. 145 Zoom In Zoom Out | ¢

Data Log Navaigation and keyboard shortcut keys.

Right and Left arrow keys - pan cursor right and left, use SHIFT + Right/Left and CTRL + Right/Left keys to pan by small increments.
| -Zoom in, O - Zoom out.

Left click on chart title at top of window to turn chart ON/OFF in the graph.

Right click on chart title at top of window to set chart options.

Left click on current chart title (top right side of graph) to select next chart.

Right click on graph to set run start and end time.

To change the grouping of chart titles, hover mouse over top of graph and when the cursor changes, left click and drag graph height up
or down as desired.

The graph settings will be saved when the program is closed and reloaded when the program is launched.
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Wiring Diagram

20ga Orange

\E_l |nnucr|or|

SDLUTIDNS

Q_; 14ga \"ellulw
14ga Red I:?‘:
12ga Red 2
12ga Blue }
- [ i
Stagel Stagel
Nitrous Fuel
‘ Solenoid Solenoid

Ground

N

20gawnite_, Tach Signal Input - Page 26

20gaBle__ cta ge #1 Output (+12V) - Page 27

.

20ga Green

+12V Input Required

Switched +12 Volts < 20ga Red

-+ Trans-Brake/Clutch Input - Page 26

80 Amp Maxi
Fuse

/

o—\_rO
Fuse 5 Amp

(Key ON Power)

Nitrous
Arming Switch

(Key ON Power) <

GND  +12V
o

8ga Red

Ground

Switched +12 Volts

Fuse 5Amp
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.. i |
NPC-2006 |

14ga Orange

20ga Red

20ga Black

[ 14ga Red
T 11

12ga Red

12ga Purple

Stage2
Fuel
Solenoid

Stage2
Nitrous

Solenoid

80 Amp
Minimum
Relay

the kit.

20ga Orange

O

Wide Open
Throttle Switch

_

Relay Out (Ground) - Page 27 Y

20ga Brown

Stage #2 Output (+12V) - Page 27,/

Ground

20ga Purple

This relay is included with
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Transmission Brake/Clutch Input Wiring

Important Information—when then Trans-Brake/Clutch input is ON the Activation input will be ignored until the transmission brake or
clutch is released. This keeps the nitrous OFF when the Trans-Brake/Clutch input is ON and the throttle is wide open.

Trans-Brake/Clutch INput /e

Trans-Brake {
Solenoid
A

P —
50 o—\_0 +12 Volt
| | Fuse >
Push I‘?.utton Arming Switch
Switch

Ground

+12 Volts Trans-Brake/Clutch Input > +12 Volt
< o0
Fuse Ground
Size according to load. Clutch Switch

Example - 10 amps

RPM/Tachometer Input Wiring

Typical aftermarket CDI ignition tachometer wiring. See ignition manufacturer instructions for more information.

Caution—never connect the white tach signal wire directly to the coil negative wire with a multi-spark ignition.

Coil negative (hot CDI)

Connect white tach signal wire
here when not using a CDI or

TACH
TRIGGER
WIRE

(white tach signal wire)

multi-spark ignition.

TACH
OUTPUT
TERMINAL

The tach input signal can also be connected to a +5 volt or +12 volt square wave signal on newer fuel injected vehicles. You will need
to research the vehicle in question and check to see if the ECM provides a tach (rpm) signal. You may also purchase an aftermarket
tach signal adapter if needed.

Connect white tach signal wire here.
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Stagel +12 Volt Timer Output Wiring

This output provides +12 volt at 1 amp maximum, there is an internal 1k ohm resistor to ground so the output is not floating when in

the off state. If your ignition and/or ignition timing controller is activated by a +12 volt signal the 20ga Blue Stagel Output wire can be
connected directly to retard activation.

Important—always test for proper timing retard operation before spraying nitrous! You can use a timing light or a data logger if it is
equipped to log ignition timing. Do a dry test (engine running, solenoids unplugged) to confirm proper timing retard.

+12 volts to load up to 30 amps.

30 amp relay
To control a load greater than 1 amp a relay will need

to be wired into the system as outlined to the right.
Connect to Blue 20g
Stage1Timer output

Switched +12 Volts <
wire from controller.

(Key ON Power)

o\ _—0O
Fuse

Size according to load.
Example - 10 amps

Ground

Stage2 +12 Volt Timer Output Wiring
This output provides +12 volt at 1 amp maximum, there is an internal 1k ohm resistor to ground so the output is not floating when in

the off state. If your ignition and/or ignition timing controller is activated by a +12 volt signal the 20ga Purple Stage2 Output wire can
be connected directly to retard activation.

Important—always test for proper timing retard operation before spraying nitrous! You can use a timing light or a data logger if it is
equipped to log ignition timing. Do a dry test (engine running, solenoids unplugged) to confirm proper timing retard.

+12 volts to load up to 30 amps.

30 amp relay
To control a load greater than 1 amp a relay will need
to be wired into the system as outlined to the right.

Connect to Purple 20ga
Stage2 Timer output
wire from controller.

Switched +12 Volts _
(Key ON Power) oo

Fuse
Size according to load.
Example - 10 amps

Ground

Relay Ground Output Wiring

+12 volts to load up to 30 amps.
This output provides a ground with a 1 amp
maximum load.

30 amp relay If you are driving an LED shift light and it draws
less than 1 amp of current it can be connected

directly to the Brown wire with no relay needed.

Switched +12 Volts

If the load is over 1 amp a relay must be used.
(Key ON Power)

Fuse
Size according to load.
Example - 10 amps

Connect to Brown
wire from controller.
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Controller Firmware Update
The NPC-2006 controller can be updated using the USB interface. An update installs new firmware (software) into the controller.

The firmware update file should be copied to C:\My Documents\Nitrous Power Controller\Firmware Updates so it can be located easily
during the update process.

When the controller enters update mode a copy of the current installed firmware will be made and placed into the update file directo-
ry automatically. If an identical firmware file already exists no second backup copy will be made.

Important—do not turn off power to the controller or unplug the USB cable during the update process. If this does occur the controller
will remain in update mode and when the USB connection is established again the update process must be completed from the begin-

ning.
Important—make sure the nitrous arming switch is off during the firmware update process.
1—turn power on to the controller and connect the USB cable. Launch the PC software.

2—Click on “Update Controller Firmware” from the Controller menu.

e
©3 NPC-2006, Nitrous Power Controller Version 1.0.2

File | Controller | Preferences Data Help

7 lHE  Download Setup from Controller

Stage ¥ Upload Setup to Controller

Setuy|'T! Download Data Log from Controller

SHI'—*' Update Eontroller Firmware |

3—click on Yes to continue and put the controller into update mode.

-

Confirm controller update [i—&J

f 3 1 Controller Firmware Update - if you continue the controller firmware
"Y' will be erased and you MUST have a firmware update file to load into
~ the controller. Do NOT continue unless you have a correct firmware
update file. Check the manufacturers web site for availability of

updates.

Continue with controller firmware update?

4—once the controller reboots in update mode click on the “Close” button to continue the firmware update process.

Help @
Controller is update mode if you entered this mode unintendedly there will be a backup Firmware
Image file in the My Documents\Nitrous Power Controller\Firmware Updates directory. If you are
loading an updated firmware image file choose the new file when prompted to do so.

Do NOT power down the controller or unplug the USB cable during this process.

Close |] Continued on next page.
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5—please be patient while the controller update continues.

»
Erasing controller firmware memory.

[

Erase Address:

bx08039800

6—when prompted select the new firmware file to load and click on “Open”

Open

N
uu |1. <« 05(C:) » Users » Dennis » My Documents » Nitrous Power Controller » Firmware Updates

= | + | | Search Firmware Updates o

|-|

Organize = New folder

H=

0 @

@) Creative Cloud Files

B Desktop

& Downloads
& OneDrive
| Recent Places

4 Libraries
@ Documents

J’ Music

|| Pictures

B videos
% Homegroup
18 Computer

& os(c)

e Induction Solutions Drive (F:)

-

MName

|| NPC-2006 1-0-0.npi

m

Date modified

6/15/2016 7:25 AM

Type
MPI File

Size

481 KB

I

File name:

> [enpi)

[Lopen ] |

7—please be patient while the controller update continues.

-
Writing controller firmware memory.
3

(S5

Write Address:

ki

px08016CA4

8—when the firmware update process is complete click on “Ok”.

i
Firmware Update Success...

=35

Controller firmware has been successfully updated!
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Appendix A—Setting up the controller for a run

1—Creating and saving a user setup file to the PC.
A—Launch the Nitrous Power Controller software.

Note—if you have the “Preferences->Load Last File on Startup” option checked the setup file that was open the last time the software
was used will automatically be opened when you launch the software. If this option is not selected a default setup will be opened.

B—Edit the setup as desired.

C—Save the setup to the PC using “File->Save File” or optionally click on the Save File icon H on the toolbar. If the setup is being
saved for the first time you will be prompted to enter a filename before saving.

Note—if you want to save the setup file with a new name use “File->Save As” or optionally click on the Save As icon on the
toolbar.

2—Upload a user setup to the controller from a saved file.

A—Open a setup file from the PC by using “File->Open File” or optionally click on the Open File icon ‘} on the toolbar.
B—Connect the USB cable to the controller and the PC. Make sure the controller is powered up.

Note—you can look at the status bar at the bottom of the software window to see if the controller is connected.

C—Upload the setup to the controller using “Controller->Upload Setup to Controller” or optionally click on the Upload Setup to Con-

troller icon D on the toolbar.

D—Watch the progress bar in the lower left corner to confirm upload progress. SRR | NPC-2006 Controlier Connected |

E—Click on “OK” when the upload complete message is displayed.
Note—the PC is used to save many setup files, only one setup can be uploaded to the controller at a time.

F—The controller is now ready to use with the setup that was saved to the PC.

3—Modifying a setup from the controller.
A—Connect the USB cable to the controller and the PC. Make sure the controller is powered up.
Note—you can look at the status bar at the bottom of the software window to see if the controller is connected.

B—Download the setup to the PC using “Controller->Download Setup to Controller” or optionally click on the Download Setup to Con-

troller icon o on the toolbar.

C—Watch the progress bar in the lower left corner to confirm download progress.

|| NPC-2006 Controller Connected

D—Click on “OK” when the download complete message is displayed.
E—Edit the setup as desired.
F—The setup may be saved to the PC using “File->Save File” or optionally click on the Save File icon H on the toolbar.

G—Upload the setup to the controller using “Controller->Upload Setup to Controller” or optionally click on the Upload Setup to Con-

troller icon O on the toolbar.

D—Watch the progress bar in the lower left corner to confirm upload progress.

|| NPC-2006 Controller Connected

E—Click on “OK” when the upload complete message is displayed.
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Appendix B—Typical procedure when making a run

A—Edit and upload a setup to the controller.

Important—it is the responsibility of the user to create a proper setup for their application!

B—Perform any usual pre-race preparations, clean tires, purge nitrous system, etc.

C—Make sure nitrous arming switch is on.

D—When the T-Brake/Clutch Input is on the Activation Input will be ignored until you release the trans brake or clutch.

Note—as long as the T-Brake/Clutch Input is on you can go wide open for the launch without the progressive nitrous system starting.

Important—if you are using the T-Brake/Clutch Input Delay Timer the T-Brake/Clutch Input will be ignored after the initial launch for
the amount of delay time set for this feature.

E—Stage the vehicle and launch.
F—The data log will begin recording once the data recording activation conditions are met.
1—the default setting for data recording activation is the Activation Input only.
2—you may configure the controller to only begin recording when the Activation Input and the T-Brake/Clutch are both on.
3—you may also configure the controller to begin recording based on engine rpm.
Please see the “Data Setup” tab for these options.

G—After the run you may turn the power off to the controller. The data log will be saved in the controller even with no power for sev-
eral years.

Note—if you start another run before downloading the data log it will be over written!

H—See “Appendix C—Retrieving data log after a run” for more information.
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Appendix C—Retrieving data log after a run

1—Download data log after a run.

A—Launch the Nitrous Power Controller software.

B—Connect the USB cable to the controller and the PC. Make sure the controller is powered up.

Note—you can look at the status bar at the bottom of the software window to see if the controller is connected.

C—Download the data log to the controller using “Controller->Download Data Log from Controller” or optionally click on the Down-
load Data Log from Controller icon Irﬁ on the toolbar.

D—Watch the progress bar in the lower left corner to confirm upload progress. SSEEEEREEE || NPC-2006 Controlier Connected |

E—When the download is complete a message box will inform you if the current setup in the controller was used when the data was
logged (same setup used for run). Click OK to continue.

1—If the setup has changed from the time when the run data log was created it will not be saved with the data log to the PC.
2—If the setup was used when the run data was recorded it will be saved with the data log to the PC.

Note—the setup can be loaded from the data log at a later date. For example you return to a track and want the same setup that was
used on a previous run. See below for instructions to retrieve the setup from a data log file.

Important—always download the data log before making any changes to the setup if you wish to have the setup saved with the data
log.

F—The save data log window will now open and prompt you to save with the automatically generated file name or you may alter the
filename before saving.

G—After saving the data log to a PC file the data graph will open and you can view the run data.

H—Click on the “Data Graph Help” button for help with the data graph functions.

2—Retrieving setup from data log file saved to PC.
A—Launch the Nitrous Power Controller software.

B—Open a data log file from the PC by using “Data->Open Data Log File” or optionally click on the Open Data Log File icon |[\/ on
the toolbar.

C—Click on the “Load Setup from Data Log” button.
1—If a valid setup was saved with the data log it will be loaded and you can view, edit, save, and/or upload to the controller.

2—If the setup was not saved with the data log you will not be able to retrieve it and a message box will appear indicating
this.
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